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CHAPTER 1

Starting the ActiveVOS Server

This chapter includes the following topic:

e Starting the ActiveVOS Server, 4

Starting the ActiveVOS Server

The Process Server consists of the Process Server engine running under Apache Tomcat 7.0.33. Tomcat is

the servlet container that is used in the official reference implementation for the Java Servlet and JavaServer
Pages technologies.

Starting the Process Server:

Note: If the Process Server already exists in the list of Servers, skip to step 4 to start it.
1. Select the Servers view in the lower right of the workspace.

2. Right-mouse click within the Servers view and select New > Server.

3. Inthe Server type list, select Process Server, and select Finish.
4

Select the Start the Server button, as shown in the example.

= = — — = ———
£ Properties .& Problems | ¥ Tasks | 4k Servers ©f Ej’l Errar Log |

Server - State

Eﬁj Stopped Republish

As the server starts up, you see start up tasks scroll in the Console. Several files are deployed to the
embedded server each time you start it. Many of these files are for BPEL for People activities that you may
want to create for your next project. When the server is started, the message indicates this, as shown.



= Properties | [21 Problems | =] Tasks | &b Servers QlEerr Log El consal= 2 =T
Ackivel0s 6,0 [Generic Server] CAckivevosaiDesi i '

® @ &) &) = T~
[INFO] [ loancCEM.bpr] Finishing BFER archiwve deployment. i
[INFO] [loanProcessCompleted. bpr] 3tarting BEPR archiwve deplovien
[INFO] [ loanProcessCompleted.bpr] Finishing EPER archiwve deplovine
[INFO] [ loanProcessHumanCompleted.bpr] 3tarting BEPE archive depl
[INFO] [ loanProcessHumanCompleted. bpr] Finishing EBEPE archiwve dep
[INFO] [riskAssessment .bpr] 3tarting EPE archive deployment.
[INFO] [riskissesswent .bpr] Finishing BPR archive deployvment.

ug 6, 2005 9:26:54 AM org.activebpel.rt.axis.bpel.webh. LeProces
INFO: ##&*&*xx®xx+® hotiveVWOd Enterprise Started
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CHAPTER 2

Human Approval Sample

This chapter includes the following topics:

Getting Started, 7

Preparing the Process for Human Interaction, 8

Adding Human Interaction, 10

Completing the Human Review, 25

Updating Fault Handling, 26

Simulating the Process, 27

Creating a Request Form, 28




Getting Started

To start, you are going to create a new orchestration project using the Human Approval sample template.

1. In Process Developer, select File > New > Orchestration Project from the main menu.
i B
f® New Orchestration Project uﬂlﬂ

Orchestration Project —

Create an orchestration project. The orchestration project @
nature is optimized

Project name: Hur‘nanﬁlpprnvaﬂ

LIse default location

Location: | ChUsers\bkingsbu\workspace\HurmanApproval Browse...

® < Back Mext = ] [ Finish ] ’ Cancel

L

2. Enter HumanApproval as the project name and click Next.

3. From the list of Available Templates, select Human Approval.

Getting Started 7



I® New Orchestration Project uﬂlﬂlﬂ

Mew Orchestration Project from Template —
Opticnally choose a Project Template to use as the starting point for your new ::' ;"J

Orchestration Project.

[¥] Create an Orchestration Project using one of the templates
Available Ternplates:

4 = ActiveVO5S + | This sample builds on the basic loan approval
2 Default Orchestration ‘ tutonal, but instead of an automated loan

2 Java Enabled Orchestration approval web service, a People Activity is used
4 @ AcliveVOS Samples L to submit the loan to a human loan approver

| for a decision.
G2 Tutorial
(2 Tutorial Completed ‘
[ L
2 Human Approval Completed
2 On Event Adjust Threshold
2 User Reports

i A Fiitboens Covncbinme amd ¥Wloae.
4 | i | F

@ Next > Finish | [ Cancel

L% A

4. Click Finish.

Preparing the Process for Human Interaction

8

The process that is explained here is based on the Loan Approval process that is built when you complete the
Process Developer Tutorial. During this part, you will:

e Replace the Web service that determines if a loan is approved or rejected with a people activity so that a
person can make this decision.

e Update the logic to return an immediate acknowledgment to the loan requester if this path of the process
is taken.

e Send a message to a customer service representative after the people activity completes.
Step 1. Remove the Invoke Loan Approver Activity

Since the decision to approve or reject a loan is now handled by a person, you need to update the loan
approval process by removing the call to the loan approver Web service. This call will be replaced by a people
activity.

1.  From the Project Explorer, expand the bpel folder and open the loanProcessHuman.bpel process.

2. Select the Invoke Loan Approver activity on the canvas, right-click, and select Delete.

3. Inthe Outline view, expand the Participant Partner Links section, right-click on the LoanApproval node,
and delete it. This removes the LoanApproval participant from the Participants view.

Chapter 2: Human Approval Sample



Step 2. Update the Reply Sent to the Loan Requester

Before invoking the people activity, it makes sense to reply back to the loan requestor, informing the
requestor that the loan will be reviewed. Do this by updating the reply activity that follows the Invoke Loan
Approver activity just deleted.

Next, format a message indicating that the loan is now under review. Do this by defining the data properties
associated with the Reply activity. This implicitly builds an Assign statement that initializes the message
variable.

1. Select the Return Approval Response reply activity and rename it to Under Review.
Select the Under Review activity.

In the Properties view for this activity, select the Data tab.

Change the Assignment from Single Variable to XPaths.

Press the Add button to create a new XPath copy expression.

A T o

Edit the XPath expression as follows:
¢ In the first column headed E/L (for Expression/Literal), select Literal.
e Inthe From column, select the ... button (the dialog button) to open the Literal Contents dialog.

o Select Generate, and then Finish to accept the default values to create the
loan:loanApprovalResponse element.

e Change the values in the generated XML as follows. The result is shown in the following illustration.
- Change the value in the <loan:responseToLoanRequest> element to underReview.
- Remove the value of stringin <loan:responseDescription>.

- Because it is not needed, you can delete the optional <loan:rejectionReason>...</
loan:rejectionReason> element.

' ™
B Literal Contents [é]

Edit literal contents:

<loam:loanfpprovalResponse xminsiloan="http://schemas.active- »

endpoints.com,/sample/LoanRequest/2008/02/loanRequest.xsd”=
<loamiresponseToloanRequest» underReview< loaniresponseToloanRequest>
<loan:responseDescription,/>

</loan:lcanfpprovalResponses

':?:' Generate... ] [ oK ] [ Cancel

L A

7. Because you are allocating a literal value for the entire content of the approval variable, there's no need
to specify a value for the To Path part of the assignment.

8. Delete the approver variable from the Variables section in the Outline view. It is no longer needed.

Your process should look like this:

Preparing the Process for Human Interaction 9



large loan or

review risk
(=

Under Review

) Chedk
% q-_(_ Assess Risk Risk
o— - S—-—
Receive Loan ] Approve

Application

Adding Human Interaction

After an acknowledgment is sent to the loan requester, add the People activity to the process.
Step 1. Add the LoanApproval Human Task Participant and Task Owners and Administrators
To create the human interaction for approving a loan, use WS-BPEL For People and WS-Human Task features.

A group called loanreps can claim and work on the tasks, while a group called loanmgrs would be
administrators--they can escalate and reassign tasks. In BPEL, these are called a Logical People Group. They
are added in the Participants view under Human Task Participants.

Logical People Group definitions must be defined for both loanreps and loanmgrs, and then they aree
associated with the proper role for the task.

1. Inthe Participants view, right click Human Task Participants, and select New Human Task Participant.
You will need to add a new participant role named Rolel to the Participants view.

2. Select Role1. Edit the value for Name from Role7 to loanreps. Later, when defining a deployment
descriptor for the process, you will associate this Logical People Group name with an actual set of users
that the configured Identity Service will resolve at runtime.

3. Repeat Steps 1 through 2 to add a second Logical People Group, this time naming it loanmgrs.

10 Chapter 2: Human Approval Sample



Step 2. Create the loan approval Human Task

Now that you've declared the Logical People Groups, you can define its tasks. Start with WSDL defining the

interactions. You can reuse the LoanApproval WSDL that was removed from the process earlier, but this time
it will provide definitions for interaction with a person instead of a service.

1.

In the Participants view, right click the loanreps Logical People Group, and select New Human Task....
The Human Task dialog opens, showing available port types. Remember that in WS-BPEL For People,

people activities are just another type of service interaction, and they are declared in WSDL.

Expand the loanProcessHuman - Imported Services then the LoanApproval to display the approve

operation, select it and press OK.

ﬂ Human Task

=)

Task Mame: Taskl
Interface
type filter text

4 |52 loanProcessHuman - Imported Services
4 | LoanApproval
» |/ approve
. I LoanProcess
. I RiskAssessment
> = Project and Project Reference Services
» [= Other Workspace Orchestration Project Services

Mamespace: http://docs.active-endpoi...2008/02/loanApproval wsdl

Interface: LoanApproval E™

Operation:  approve

’ Generate Interface... ]

Cancel

@

T

L

A new task will appear in the Participants view, under loanreps, called Task1.

Select Task1 so that is displayed in the Properties view. Edit the value of the Name property to

approveTask.

Set the Priority to 3. Your task properties should look similar to the following:

Adding Human Interaction
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12

Process Activities| Fault Handlers | Event Handlers | Source |
5= Outline = = (] _B_\ Problems | & Relationships UL Servers @ Error Log | = Properties b
4 [i| loanProcessHuman = | =§-| Show
4 & Human Interactions
4 @ Logical People Groug M approveTask

$ loanreps

Task Name:  approveTask
3 loanmgrs B == -
4[] Tasks F fE.‘Eﬂ e =1 Eioane |2
= Assignment

E' approveTask
[;1'] MNetifications
= .
* {3 Extensions
] Imports
> (g} MNamespaces

m

Deadlines TaskInterface: approve/approvews:LoanApproval
Renderings .

 Documentation ._

Al |

5. Select the Presentation side tab in the Properties view and set the following properties:

e Display Name: Loan for review

e Subject: Please look at this loan and approve or decline it. (for {S$loansummary})

e Type:default
| El Properties S o ﬁ:_gi?%

@ approveTask

Task _ Display Mame; iElfor review
Presentation Subject: [ please look at this loan and approve or decline it, (For {$loansummary})
Assignment
Deadines
Renderings
all - Description
Type: |default v], [ + ] [ - l
Content:

6. Still at the Presentation tab, define the 1oansummary substitution variable that was just entered in the

Subject area:

o

Press the ellipsis button at the right of the panel.

b. Inthe Presentation Parameters dialog that appears, press Add to add a new parameter. A new

parameter called paraml whose type is string will appear.
c. Click on the Parameter name to make it editable, and enter loansummary.
d. Leavethe Type as string.

e. Click on the expression to make it editable, and enter the following value:

concat (htd:getInput ('Document')/loan:lastName , ", ",
htd:getInput ('Document')/loan:firstName , "; $",
htd:getInput ('Document')/loan:amountRequested )

Your dialog should look similar to this:
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r ™
[® Presentation Parameters ﬂ]

Presentation Parameters

Expression Language:

urn:oasisinamestowsbpel:2 0isublangixpathl.0 D
Parameter Type Expression Add
loan5urmmary string concat( htd:getinput(' Document')/loan:lastMam...

Remawe

@ Lok ]

Cancel

Step 3. Complete Binding the Task Owners and Administrators to
the Task

The Potential Owners Role was automatically set to loanreps when you created the task. You now need to
assign other users to some of the other task roles. Do this by assigning the 1oanmgrs Logical People Group
to the Business Administrators role, and by assigning the Loan Process literal to the Task Initiator role.

1. Select the Assignment tab and set the value for Business Administrator to loanmgrs as follows:

a. Click in the Value column for Role Name Business Administrator. An ellipsis button appears. Click it

to display the Role dialog.
b. Inthe Role dialog, select Logical People Group in the Type picklist.

c. Inthe Group picklist, select loanmgrs, and press OK.

i '
B® Role: Business Administrator ﬁ

Type: ’Logical People Group vl
Group: |loanmgrs -
lzanreps |

@ [ ok [ Ccancel

L

2. Still at the Assignment tab, set a value for Task initiator as follows:

a. Click in the Value column for Role Name Task Initiator. An ellipsis button appears. Click it to display

the Role dialog.

b. Inthe Role dialog, select Literal in the Type picklist.

Adding Human Interaction 13



c. Select Generate to generate XML for a user.
d. Edit the value of the ht:user element to say Loan Process.

e. Your dialog should look like this:

® Role: Task Initiator @

Type: ’Literal -

<ht:organizaticnalEntity xminsht="http://www.examp  »
<htiusers>
<ht:user=Loan Process</htiuser=
< /htiusers=
= /ht:organizationalEntity =

4 L k

Generate...

@ [ ok |[ concel |

Step 4. Setting Task Deadlines

You can specify one or more deadlines by which a task must be started and also one or more deadlines by
which a task must be completed. If a start or completion date is missed, you can trigger one or more
escalation actions. For example, if you set a start the task deadline for two hours after a task is created and
the deadline is missed, you can send a notification to the task owner. Here are the deadlines you will set:

e A start deadline that is triggered if the task is not claimed and started by a loanrep within 2 hours.
e A completion deadline that is triggered if the task s not completed by a loanrep within 130 minutes.

Step 4a. Setting the Start Deadline

1. From either Participants or Outline view, select the approveTask node and select the Deadlines side tab
in the Properties view.

2. Click the Add button and set the properties for Deadline Type to Start, the Alarm Type to Duration and the
Escalation Type to Inline Notification.

14 Chapter 2: Human Approval Sample



R Deadline Specification

Specify the type of Deadline to be created

Deadline Type
@) Start

(") Completion
Alarm Type

(") Deadline

@ Duration

Escalation Type: |Inline Motification

@

Lok |

Cancel

L

Press OK.

4. Click in the blank value under the Expression column and press the ellipses button (...) and set the
duration expression to the following: 'pT120M'. Include the single quotes in what you type.

5. Repeat steps 1-4 and create a completion deadline with a Duration Alarm Type for 10 minutes later

("pT130M").

6. The two task deadlines appear in the Properties view:

Task

. Presentation
”Assignment
 Deadlines

Ren d-éri.ngs

Documentation

Al

7. Inthe Outline view, select the Start Deadline and select the Escalations side tab in the Properties view.

[¥] approveTask

Deadlines

Type Alarm Type Expression
Start Duration 'PT120M°
| Completion  Duration 'PT103M"

8. Select the Inline Notification labeled InlineNofication1 and press the Go To button.

9. Inthe Properties view, select the Notification tab and change the name to TwoHourReminder.

Adding Human Interaction
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5F Outline &3 = O[3 Problems | # Relationships | 4 Servers | 9] Error Log | ] Properties &2

@ loanmgrs a =

4 [/] Tasks
4 [7] approveTask [& InTwoHourReminder
rl fj’ Start Deadline: Duration('PT12( e ox .
L—\ - - ( Notification Name: [ TwoHourReminder
4 B InTwoHourReminder = —
= - ocumentation
[ ReminderToReps o

> Ej Completion Deadline: Deadliny Condition:
|:1'J Motifications

i | .
* [fg Extensions

m

Data
@ Use Task Data
() Map Data

(5] Imports
> Q» MNamespaces
> [ Participant Partner Links
+ (x) Variables —
b Sets

P Expression

Correlaty

10. In the Outline view, expand the TwoHourReminder node and select the child node labeled N1. This is the
where you define the escalation action that is triggered if the deadline is reached.

11. Inthe Properties view, select the Notification tab and set the following properties:
e Name: ReminderToReps
e Priority: 2

12. Press the ellipsis button to the right of the Notification Interface field.

13. In the Notification Interface dialog that appears, navigate to the LoanApprovalPeople port type, and
select the remind operation.
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i A
R Notification Interface: ﬁ

Interface

type filter text

4 [~ Project and Project Reference Services
4 2 HumanApproval
4 It LoanApprovalPeople
s | remind
I LoanCRM
> [ Other Workspace Orchestration Project Services

Mamespace: httpe//docs.active-endp../loanfpprovalHumanwsdl

Interface: LoanApprovalPeople (S35

Operation:  remind

’ Generate Interface... ]

@ [ ok || cancel |

L A

The remind operation is a one-way operation that notifies loanreps that a loan application has waited
two hours for review. The Notification tab should look similar to the following:

[ ReminderToReps

- 1
Motification Mame: ReminderToReps
Presentation Priority: 2 E]
Assignment
Renderings Motification Interface:  remind/loanApprovalHurman:LoanApprovalPeople B

Documentation

All

14. Inthe Properties view, select the Presentation tab and set the following properties:
e Display Name: Unclaimed Task reminder

e Subject: There is a loan task waiting to be claimed. ({$lastname}, {$firstname}; $
{$amount} priority {S$priority})

e Description Type: default

Adding Human Interaction 17



e Description Content: A loan review has been unclaimed for 2 hours. Please go to your
inbox and claim if appropriate.

[ ReminderToReps

Motification

T Pt Display Mame: Unclaimed Task Reminder

.Assignment | Subject: There is a loan task waiting to be claimed. ({$lastname}, - E
- | {Sfirstname}: 5{Samount]} priority {Spriority})

Renderings

Documentation

All
- Description

Type:[default ’” & H & ]

Centent: h loan review has been unclaimed for 2 hours, Please go to your =
inbox and claim if appropriate.

15. Inthe Properties view, select the Presentation tab, press the ellipsis to the right of the Subject field, and
set the following presentation parameters:

Parameter Type Expression

firstname string htd:getInput ('Document', 'approveTask')/loan:firstName
lastname string htd:getInput ('Document', 'approveTask')/loan:lastName

amount string htd:getInput ('Document', 'approveTask')/loan:amountRequested
priority string htd:getTaskPriority()

Your completed dialog should look similar to this:

r ~
ﬂ Presentation Parameters &J

Presentation Parameters

Expression Language:

urn:oasis:names:tawsbpel:2.0:sublang:xpathl.0 E]
Parameter Type Expression Add
firstname string htd:getlnput{'Document’, 'approveTask')/loan:firstName
| | Document, -
astname string htd:getlnput('Document’, 'approveTask')/loan:lastMName
amount string htd:getlnput('Document’, 'approveTask’)/loaniamountRequested
priority string htd:getTaskP riority()

® QK l ’ Cancel

"

16. Press OK.

18 Chapter 2: Human Approval Sample



17. Inthe Properties view, select the Assignment tab, click in the Value field, and set the Recipients to
loanreps and Business Administrator to loanmgrs.

[ ReminderToReps

Motification

Role Name Type Value
Ssenialion Recipients Logical People Gro..  loanreps
Assignment Business Administra... Logical People Gro...  loanmgrs
Renderings

Documentaticn
All

Step 4b. Setting the Completion Deadline

1. Inthe Outline view select the Completion Deadline and press the Escalation tab in the Properties view.
Select the Inline Notification labeled InlineNofication1 and press the Go To button.

In the Properties view, select the Notification tab and change the name to EscalateIfNotActedUpon.

In the Outline view, expand the EscalateIfNotActedUpon node and select the child node labeled N1.

o M WD

In the Properties view select the Notification tab and set the following properties:
e Name: NotifyReassignToManager
e Priority: 1

o Notification Interface: remind/loanhuman:LoanApprovalPeople

5% Outline 52 = 8|/ Problems | f& Relationships | & Servers | €] Error Log | £ Properties £
) gloanmgrs - :’| E—
[¥] Tasks -
[4) 2pproveTask [ NotifyReassignToManager

[% Start Deadline: Duration('PT12{ |

o Maotification Name: NotifyReassignToManager
[& mTwoHourReminder

Presentation

[ ReminderToReps Priority: 1 B
L-_i c letion Deadline: Durat Assignment
= 2
S o s e o ‘m‘ Renderings Notification Interface: remind/laanApprovalHuman:LoanApprovalPeople &
[ EscalzedifNotActedUpon |=
B NDtlfyREasslgnTDMar‘ Documentation B Notification Interface: @
[ Notifications Al
= Interface
% Extensions
€D Imports type filter text
@3 Namespaces 4 &) loanProcessHuman - Imported Services
J‘MWWMM 4 [ LoanApprovalPeople

4 & remind
™ Input: creditinformationMessage
4 (= Project and Project Reference Services
4 (2 Humanapproval
4| [ LoanApprovalPeople
4 . remind
* Input: creditinformationMessage
> I LoanCRM
> = Other Workspace Orchestration Project Services

B e T S S
6. Inthe Properties view select the Presentation tab and set the following properties:
e Display Name: Escalated To Manager

e Subject: This loan is being reassigned to loanmgrl for review

Adding Human Interaction
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e Description Type: default

e Description Content: Needs to be completed within 10 minutes!

5% Outline 520 =0 E?_g Prob\ems_..i' Relationships | §4 Servers Q-' Error Log | Bl Properties 2%
e : c4 | show ~[8
4 [J] Tasks =
4 [/] approveTask D NotifyReassignToManager
4 [F Start Deadline: Duratio| ||| .
&'—‘ @i e g o Notification
4 InTwoHourRemini EE Display Mame: Escalated To Manager
[;1_] ReminderToR Presentation ;
- | Assignment | Subject: This loan is being reassigned to loanmgrl for review
- E‘J_{ Completion Deadline: -
- =||| Renderi
B B EscalaedifNotActe = ||| oo g m—
D MotifyReassig || |- DoFumentatlon .
=) | All
- [ Notifications Description
" [ag Extensions
> ‘B Imports L Type: |geiaull v] E

> @b Mamespaces
» m Participant Partner Links
> (x) Variables

R Py ) [ [T, N Y STy

Content: Needsto be completed within 10 minutes!

7. Inthe Properties view select the Assignment tab and set the Recipients to loanreps and Business
Administrator to loanmgrs, as you did in a previous step for Reminder to Reps.

8. Inthe Outline view select the Completion Deadline and press the Escalation side tab in the Properties
view.

9. Press the Add button and specify Reassignment for the Escalation Type:

s ™)
BR Escalation Specification @

Specify the type of Escalation to be created

Escalation Type: [Inline Motification v]

Inline Motification
Local Motification
Process Invoke
Send Email

@ QK ] ’ Cancel

L5 &

10. Select the Reassignment labeledReassignment1 and press the Go To button.
11. Inthe Properties view select the Reassignment side tab and change the name to ReassignToMgrl.

12. Inthe Properties view select the Assignmentside tab and set the properties by pressing the ellipses (...)
button in the Value column:

e Select Literal for the Type.
e Press the Generate... button

e Change the value in <ht:user> from Some User to loanmgrl

20 Chapter 2: Human Approval Sample



e Press OK.
e Your Properties should look like the following:
5% Outline 32 b = m L Prob\em;(ﬁ' Relationships “ﬂ Servers (G_] Error Log | & Properties 5
@ loanmgrs &

g
R Role: Potential Owners

Type: ’ Literal

<htusers»

</ ht:users=

=htiuser>loadnmgrl </htiuser=>

< /ht:organizational Entity>

<ht:organizationalEntity xminsht="http://www.example.org/WS-HT' > »

4

T

[ »

Generate...

@

0K

/1

Cancel ]

e

4[] Tasks
4 El approveTask

o @ InTwoHourReminder
Ej ReminderToReps
- @ Completion Deadline: Dura
¢ [B EscalaedlfNotActedUp( =
m ReassignmentToMgrl
E] Nntiﬁ(at-\.on; )
[ :lljo Extensions
B ‘@Impur‘ts L4
b 4» Mamespaces

igiament er Links, P

4 E‘j Start Deadline: Duration('PT)

[43 Reassignmentl

Reassignment

Role Name
Assignment

Documentation

All

Potential Owners

Literal

Value X

users (loadnmgrl)

Step 5. Setting Task Renderings

wW

Process Developer can create an HTML Form (or an XSL file or a custom rendering) that will render the task
information in the Process Central Task forms. You can edit this form to customize how task information is
presented to the user in the Process Central web application.

1.
2.
3.

In the Outline view select the approveTask.
In the Properties view select the Renderings tab.

The Create Form button presents a dialog were you can specify the project folder and name for the
form.

You will create the form in the form folder and use the default name of approveTask.html.

Adding Human Interaction 21
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-
BR Task Form Generation

File Selection

Human&pproval form

4 122 HumanApproval
= bpel
= deploy
= form
= Partner_Servic
== sample-data
= schema
= test
s = wdl
[~ xquery

Enter or select the parent folder:

Es

File name: approveTask.html

After you select OK, the Form editor opens.

5.  You can see a preview of the form in the top half of the editor. Close the form.

6. Create Process Central forms for the task notifications by expanding the approveTask in the Outline view

and trhen creating new Process Central Forms for the two notifications: ReminderToReps and
NotifyReassignToManager (highlighted in the following figure).

e |z| approveTask |
el Lp_j Start Deadline: Duration{'PT1200
4 @ InTwoHourReminder
D ReminderToReps
4 Ej Completion Deadline: Durationi|
4 @ EscaleedIfMotActedUpon |~
D NotifyReassignToManz
m ReassignmentToMgrl
D Notifications
b 50 Extensions
i ‘"b\ Imports
b fg» Mamespaces

That's it. The task is now complete with escalations, notifications, and rendering information. All that remains

EE Outline &3 - : S (] _EL Problems | g+ Relationships | 47 Servers 6__‘ Error Log | = Properties 52
$ leanmgrs o [ma ‘ Show v
4[] Tasks

[ ReminderToReps

Netification

¥ Presentation

. .‘C\ss.i.gn mel"li

Rend erings
Documentation

All

ActiveVOS Central Form ‘ACtIVEVOS Screenflow I Custom Renderlng|

ActiveVO5 Central Form

|| Development Mode {load from file with no cache)

Form:  project:/HumanApproval/form/ReminderToReps.htrr Browse...
Edit Form
Create Form...

B L N i T

is to create a People Activity based on the task, and to place it in the process.
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Step 6. Creating the People Activity

Now that you've defined the human task, the last step is to create a people activity in the process that uses
the task. Although you've already defined most of the details of the human interaction through setting
properties associated with the task, the people activity has a few properties of its own as well, and you need
to set them as well.

1.

In the Participants view, select the approveTask. Drag it from the Participants view to a position after the

U

nder Review activity:
large loan or
review risk X é . EB approveTask
Under Review
Chedh
= 'qw Ageess Rigk Risk
| e —— —h:rW'r'rsk—P'
= =
Receive Loan Approve
Application

Select the people activity, and the associated Properties view. Edit the properties for the activity as

follows:

a. Onthe People Activity tab, change the name to reviewLoan. Select a color, such as orange.

b. Onthe Assignment tab, no changes are required. Note that the role assignment information that
was entered during task definition has been propagated to the people activity automatically. It can
be overridden here if desired.

c. The Schedule tab allows you to control when the activity is executed, and how long it is allowed to
take. These parameters are separate from the escalation deadlines that are part of the task
definition, and all are taken into account at runtime. Set an Expiration expression for a task duration
of 'pT180M', the maximum allowed duration for the people activity.

d. Onthe Input tab:
¢ In the Assignment picklist, select Single Variable.
¢ In the Variable picklist, select creditinformation.

e. On the Output tab:

¢ In the Assignment picklist, select Single Variable.

¢ In the Variable picklist, declare a new output variable as follows:
Select New Variable... and assign the following values:

- Variable Name: approve-task

Adding Human Interaction
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- Scope: Accept the default value of Process
- Variable Type: Accept the default value of Element

You have now completed the definition of both a human task for loan application review, and a people activity
using that task. You've added the people activity to the process at the appropriate location. In the final part of

the process, you will notify the Customer Service Department of the loan approval decision, so that they can
inform the customer.
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Completing the Human Review

In this section, you'll update the loan approval process by invoking a Web service that will notify the
Customer Service Department of the loan's status.

1.

In the Participants view, right click Partner Service Providers to create a new Partner Service Provider.
Navigate to the notify operation of the LoanCRM port type, select it, and press OK.

s N
BR Partner Service Provider ﬁ

Prowvider Mame:  Provider

Interface

type filter text

4 | 72 loanProcessHuman - Imported Services
- I LoanApproval

»

» I LoanApprovalPeople
» I LoanProcess
» I RiskAssessment
4 [= Project and Project Reference Services
4 g HurnanApproval
» I Loanfpproval
. B LoanApprovalPeople
4 It LoanCRM
4 o notify
1 Input: approvallMessage
. I LoanProcess
» b RiskAssessment N
» [ System Services -

m

Mamespace: (none)

Interface: (none)
’ Import Service Reference... l ’ Generate Interface... ]
@:‘ [ QK ] ’ Cancel ]

L -

The LoanCRM port type is added to the Participants view with the default name provider. Highlight this
entry in the Participants view, and change the Name value to CustomerService.

You are now ready to add the invoke to the process.

In the Participants view, expand the CustomerService provider and select the notify operation. Drag it to

the canvas and drop it just after ReviewLoan. A new invoke activity will appear, with the default name
notify.
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4. Edit the properties of the invoke as follows:

a. Onthe Invoke tab, name the activity Notify Customer Service Of Decision. Add a color, such as
green.

b. At the Input tab, select Single Variable, and select approve-task.
5.  From the Throw Event palette, add a None event after the invoke.

6. Save your process. Your process should now look similar to this:

large loan or %
review risk = ReviewlLoan Motify Customer
- = ER — ~ Service of —»O
= Decision

Under Review

- Check
= 'Qf Assess Risk Risk
| | — ™ —fum"rsk—*

Receive Lean Approve
Application

—O'rrgf'rrisk—*

Deny

Updating Fault Handling
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In this section, you will update the fault handling of the original loan approval process to handle an expired
human task.

1. Select the Fault Handlers tab.

2. From the Catch Event drawer of the Palette, drag an Error activity and drop it on the Fault Handlers
canvas.

3. Inthe Properties view, click the ... button and set the following property:
Fault Name: b4p: taskExpired (you can use the ellipses... button and select this)

4. From the Participants view, in the Partner Service Providers section, expand the CustomerService
provider and drag the notify operation inside the new Catch activity.

a. Inthe Properties view on its Invoke side tab, set the Activity Name to Notify CRM Of Expiration.
b. At the Input tab, select XPaths
c. Choose Literal for the E/L type and use the following:

<loan:loanApprovalResponse xmlns:loan=
"http://schemas.active-endpoints.com/sample/LoanRequest/2008/02/
loanRequest.xsd">
<loan:responseToLoanRequest>declined</loan:responseToLoanRequest>
<loan:responseDescription>We regret that your application
could not be processed under our Qik-Approve guidelines. Please
reapply in person at one of our offices.</loan:responseDescription>
<loan:rejectionReason>
<loan:reason>infoRequired</loan:reason>
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<loan:description>Loan underwriting could not be completed
in the recommended time window.</loan:description>
</loan:rejectionReason>
</loan:loanApprovalResponse>

d. To Part: Document

BT Outline 2 = O |['% Problems | # Relationships | 4% Servers ej Error Log | = Properties 2
'q:t Motify Customer Service: « |
) Start i
» [ Receive Loan Application | % Service
A |
BRI Invoke
&) Deny Assignment Type: [XPaths -
; _ | Input
> ¥y Assess Risk |
o R Chveck ok Output [T [From To Part
4 /) Fault Handlers Docugenietion <loan:loanApprovalResp XEY "http://schemas.active- i
> (W) Catch loanProcessFauk | Al endpoints.com/sample/L oan Request/2008/02/loanRequestssd > )
y (1) <loonresponseToloanRequest> declined</loam:responseToloank o o ‘
> (/1) Catch leanProcessFault —l equest>
4 (W) Enror | <loan:responseDescription>We regret that your application
v = could not be processed under our Qik-Approve guidelines. Plea
% Notify CRM of Expiration |' (=
Event Handlers

Catch loanProcessFault

ReplyWithApprovalFault ReplyWithAssessmentFault
Catch taskExpired
= Motify CRM of
I A e Expiration

Simulating the Process

Now that the process is complete, you should simulate its execution before deploying and running it on the
server. Detailed instructions for simulating the Loan Process are described in Tutorial Part 8, Simulating the
Process (located elsewhere in this help) so they are not repeated here. Once you are satisfied that your
process behaves as expected, you can deploy the process and run it on the Process Server.
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Creating a Request Form

Before deploying the process, you must create a request form that you can use to invoke the process on the
server. Two steps are required here:

1. Create the Request form.

2. Create a Process Central Configuration (.avcconfig) file that defines the structure and contents of the
application.

Step 1: Create the Request Form
1. Inthe Project Explorer, create a sub-folder under the form folder called request.
2. Inthe Project Explorer, right-click on the form folder and select New > Process Request Form.

3. Expand the LoanProcess port type and select the request operation as shown here:
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- B
R ActiveVOS Central Process Request Form =L

Select Port Type And Operation

Select the port type and operation to create a form.

Interface

type filter text

[= Project and Project Reference Services
2 HumanApproval
I LoanApproval
I LoanApprovalPeople
It LoanCRM
It LoanProcess
& request
I RiskAssessment
[= Other Workspace Orchestration Project Services

Mamespace: http://docs.active-endpoints.com.. process/2008,/02/loanProcess.wsdl
Interface: LoanProcess

Operation:  request

Service: LoanProcessHumanCompletedService

@ < Back Net> || Fnsh ||

Cancel

L

4. Press Next.

5.  Name the form HumanApproval.html.
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F ™y
R ActiveVOS Central Process Request Form L@ﬂ

Select Form File

Select request form location and Jhtml file name,

Enter or select the parent folder:

HumanApproval form,/request

=% HumanApproval
= bpel
= deploy
= form
[ request
= Partner_Services
[= sample-data
= schema
= test
== wsdl
= xquery
= usl
=% ScreenflowSample

'[é test

File name:  HurnanApproval html

@ Nec> | [ Finish | [ Cancel

L -

6. Press Finish.
Step 2: Create the Process Central Configuration

1. Inthe Project Explorer, right-click on the deploy folder and select New > Central Configuration. Enter a
value of HumanApproval.avcconfig for the file name and press Finish.

2. Inthe Source tab, scroll down to the Requests section and replace the <tns:requestCategoryDefs> with
this code:

<!-- Requests - example note that the values should be replaced with those from your
application -->
<tns:requestCategoryDefs>
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<tns:requestCategoryDef id="education category" name="Tutorial and Samples">
<avccom:requestDef id="hac request" name="Human Approval Form">
<avccom:allowedRoles>
<avccom:role>loanreps</avccom:role>
<avccom:role>loanmgrs</avccom:role>
</avccom:allowedRoles>
<avccom:description>Submit loan approval request (Human Approval Sample).</
avccom:description>
<avccom: formLocation>project:/HumanApproval/form/request/HumanApproval .html</
avccom: formLocation>
</avccom:requestDef>
</tns:requestCategoryDef>
</tns:requestCategoryDefs>

3. This will deploy the Humanapproval.html file to Process Central and allow access to anyone with the
loanreps or loanmgrs role. The file should look similar to this:

] loanProcessHuman.bpel [55 HumanApproval.html -] *HumanApproval.avceonfig 23

<!-- Requests - example note that the values should be replaced with those from your application --»
<tns:requestCategoryDefs>

& <tns:requestCategoryDef id="education category"” name="Tutorial and Samples™:

= <avccom:requestDef id="hac_request" name="Human Approval Form":

2 <avccom:allowedRoles>

<favccom:al
<avccom:description»Submit loan approval request (Human Approval Sample).</avccom:description:
<avccom: formLocation»project: /HumanApproval/form/request/HumanApproval. html</avccom: formLocation:
</avccom:requestDef>
</tns:requestCategoryDet>

= </tns:requestCategoryDefs>
<!-- Web applications - note that the values should be replaced with those from your application
<tns:centralfpplications>

4. Save the file.

5. Therequest form and the Process Central configuration file can now be deployed. Instructions for
deploying can be found in the Human Approval Completed Orchestration Process template.

Preparing for Deployment

In this section, you'll prepare the process for deployment by creating the Process Deployment Descriptor
(.pdd) file. For more information, see Deploying the Loan Process and Deploying the Partner Processes.

A Process Deployment Descriptor (.pdd) file describes the relationship between the partner links defined in
the BPEL file and the implementation that interacts with partner endpoints. You create a .pdd file to add
address information about your endpoint references. The .pdd file is an integral part of the deployment
package for the process.

1. In the Project Explorer, right-click on the loanProcessHuman.bpel process and select New > Deployment
Descriptor to open the New Deployment Descriptor dialog.

2. Select the deploy folder, and press Finish, as shown.
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® New Deployment Descriptor _E x|
Deployment Descriptor File
Specify a file for the deployment descriptor,
Enter or select the parent folder:
HumanApproval/deploy
= bpel -
= deploy )
= form
= Partner_Services
[= sample-data
= schema
IE:' test =
= wsdl
= xquery
= sl
=% ScreenflowSample
22 test | S

1

File name: loanProcessHuman.pdd

@ Finish | [ Cancel

L A

The loanProcessHuman.pdd file opens in the PDD editor The properties of the General tab are displayed.

4. Accept the defaults on the General tab and press the Partner Links tab to define the bindings to the web
services called by the process.
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D; HumanApproval.html = *HumanApproval.avcco 5= leanProcessHuman.pdd 5 ! ':'é
Partner Links
RiskAssessment: Incomplete partner role endpoint reference definition XML,
Mame Lecation Status
@ CustomerService Incomplete partner rele endpoint reference..,
@ RiskAssessment Incomplete partner rele endpoint reference...
loanProcessor
Partner Role My Role
" -
4 k aan 4 ]
General | Partner Links | Indexed Properties | Eventing | People | References | Source

5. Set the runtime bindings for the CustomerService partner link by clicking on the CustomerService row
and set the following properties:

e Invoke Handler: WSA Address
e Endpoint type: static

e Press the ellipses (...) button next to the textarea labeled Endpoint Reference to open the Endpoint
Reference dialog

e Select the 1oanCrRM.wsdl file from the WSDL picklist.
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34

E® Endpoint Reference | 2

Service | Policy Assertions

Select service for Partner Link "CustomerService”, Role "Provider”, implementing Port Type "loanCRM:LoanCRM",

Mamespace: http://docs.active-endpoints.com/sample/wsdl/loanCRM/2008,/02/loan CRM.wsdl

Address: urn:x-vos:loancompany:LoanCRMService

Service: LoanCRMService

Port: LoanCRMServicePort

W5DL: | loanCRM.wsdl -

Service - Port

LoanCRMService - LoanCRMServicePort

@ [ ok ][ cancel

. r

e Press OK.

Notice that the Endpoint Reference information is now filled in using the values contained in the
loancrM.wsdl file:

E‘_:’J HumanApproval.html (E *HumanApproval.avcco = *

Partner Links

RiskAssessment: Incomplete partner role endpoint reference definition XML,

MName Location Status
CustomerService

@ RiskAssessment Incomplete partner rele endpoint reference...
loanProcessor

Partner Role My Role

Invoke Handler: WS5A Address - Binding: |

Allowved Roles:

Endpoint Reference: Policy:

<wsa:EndpointReference xminsiwsa="http://wwy  +
xminsisoapenv="http//schemas.xm
xminsxsd="http:/ www.w3.org/2000
xminsins5i="http://docs.active-endp
xminsasi="http://wwwow3.org/2001
<wsa:Address> urnix-vostleancompany:LoanCR
<wsa:Metadata=>

<wsaServiceMName PortMame="LoanCRMSen

< fwesa:Metadata»

O F—— P EE r (-]

General | Partner Links | Indexed Properties | Eventing | People | References | Source
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6. Set the runtime binding information for the RiskAssessment partner link by selecting the
RiskAssessment row and set the following properties:

e Invoke Handler: WSA Address
e Endpoint type: static

e Press the ellipses (...) button next to the textarea labeled Endpoint Reference to open the Endpoint
Reference dialog

e Selectthe riskAssessment.wsdl file from the WSDL picklist.

[® Endpoint Reference =

Service | Policy Assertions

Select service for Partner Link "RiskAssessment”, Role "Provider”, implementing Port Type "riskws:RiskAssessment”.

Namespace: http://docs.active-endpoints.com/sample/wsdl/riskAssessment/2008,/02/riskAssessment.wsdl

Address: urn:x-vos:loancompany:RiskAssessmentService

Service: RiskAssessmentService

Port: RiskAssessmentServicePort

WSDL: | riskAssessment.awsdl -

Service - Port

RiskAssessmentService - RiskAssessmentServicel o~

@ I OK ] [ Cancel

e 4

e Press OK.

Notice that the Endpoint Reference information is now filled in using the values contained in the
riskAssessment.wsdl file.

7. Next set the runtime binding information for the LoanProcess partner link by selecting the LoanProcess
row and setting the following properties:

e Binding: Document Literal

e Service: LoanProcess Note that this name must match the Service name selected in the
HumanApproval.html request form, described in Creating a Request Form above.

Notice that the Endpoint Reference information is now complete:
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= e
D‘ HumanApproval.html ﬂﬁ *HumanApproval.avcco (ﬂ"ﬂ *loanProcessHuman.pd &3 4l
Partner Links

MName Location Status

CustomerService

RiskAssessment

loanProcessor
Partner Role My Role
Invoke Handler: WSDL Service Port Binding: Document Literal -
Endpaint type: Service: LoanProcess
Allowed Roles:
Endpoint Reference: Policy:

8. The final step is to bind the Logical People Groups to actual server roles. Select the People tab and
notice that the Logical People Groups are already assigned to names in the tomcat-users.xmnl file for
the Process Developer embedded server Identity Service. Because ldentity Service group names are
used in the People activity, they are already selected here.

People

Logical People Groups

Master Section

List of all logical people groups in the
process,

Logical People Group
Details of a logical people group.

4 process MName: loanreps

4 humanlnteractions

Location: /process/hurmanlnteractions/logicalPe
4 logicalPeopleGroups

loanreps Type: Use Logical People Group Name as Identity Service User/Group Name
loanmgrs

General |Partner Links |Indexed Properties | Eventing | People References| Source|

9. Save thefile.

Running the Process on the Server

Your process is now ready to be deployed. Deployment is the act of publishing your BPEL process to the
Process Server where it can run.
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CHAPTER 3

Human Approval Completed

This chapter includes the following topics:

e Getting Started with the Completed Project, 37

e Starting the Process Developer Embedded Server, 39

e Deploying the Loan Process, 39

e Deploying the Partner Processes, 42

e Running the Loan Process on the Server, 43

e Claiming Updating and Completing the Human Task, 45

e Review the Completed Loan Process, 48

Getting Started with the Completed Project

To start, you will create a new orchestration project based on the Human Approval Completed sample
template. By using this template, you will create a new orchestration project that includes a complete loan
approval process, including human interactions.

1. Open the Process Developer Designer and select File > New > Orchestration Project from the main
menu.

2. Type HumanApprovalCompleted for the Project name and press Next.
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-
ﬂ Mew Orchestration Project =rE

Orchestration Project —

Create an orchestration project. The orchestration project B
nature is optimized

Project name: | Humn anhpprwaﬂ

Usze default location

Location: | C\Users\bkingsbu\workspace\HumanApproval Browse...

@ < Back Mext = ] [ Finish 1 ’ Cancel

L A

3. Select Human Approval Completed from the list of samples to use the Human Approval Completed
template.
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B8 tew Orchestration Project I. =] ﬂ

Mew Orchestration Project from Template —

Optionally choose a Project Template to use as the starting point for your new Orchestration :_' ;
Project.

[¥] Create an Orchestration Project using one of the templates

Available Templates:

4 [= ActiveVO5 This is a completed version of the Hurman
2 Default Orchestration Approval Sample. You will be guided through
2 Java Enabled Orchestration configuring the server, deploying the loan

! process, deploying the supporting processes,

« & AthEVO_S Samples executing the process, approving the loan by
& Tutorial signing in to the inbox and claiming the human
(2 Tutorial Completed task and viewing the state of the process on the
fg Human Approval =ERNEL:

[g Human Approval Completed
[Z_% On Event Adjust Threshold
[g User Reports
2 Custom Functions and XQuery
4 [ Screenflow
2 Screenflow Demo
E—% Screenflow Customization Starter
fg Screenflow Host Provider Template

@ Next > Finish | [ Cancel

L8

4. Press Finish.

Starting the Process Developer Embedded Server

Before you can deploy the Loan Process and the supporting partner processes to the Process Developer
Server, you must start it. Instructions for starting the server are in Starting the Process Developer Server
located elsewhere in this help. After starting the server, continue to the next topic.

Deploying the Loan Process

To deploy the Loan Process, you need to create a Business Process Archive (.bpr) file by exporting the
Process Deployment Descriptor (.pdd) file. These files are packaged in the deploy folder of this sample
along with another file containing a .bprd extension.

1. Inthe Navigator view, right-click on the HumanApprovalCompleted project and select Export.

2. Expand the Orchestration folder and select Contribution - Business Process Archive.

Starting the Process Developer Embedded Server
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(8 Export EET)
Select /1

Export a contribution of processes and resources packaged in a business I g 5 l
process archive (bpr) for deployment to an ActiveV 05 Enterprise Server,

Select an export destination:

type filter text

» = General

[ = EB

» == Java

» = Java EE

4 [~ Orchestration
rﬁ_ Contribution - Business Process Archive |
5| Export to XPDL

» [ Plug-in Development

> (= Run/Debug

[ = Tasks

» = Team

» = Web

» = Web Services

B = XML

@:l < Back Mext = Finish N

e e -_ - E

Press Next.
4. Set the following properties:
a. Make sure that the loanProcessHumanCompleted.pdd file is selected.

b. Press the Browse button and navigate to the deploy folder of your project and specify a file named
loanProcessHumanCompleted.bpr. Note: the file is overwritten if it already exists.

c. Select Web Service from the Type picklist.

d. Create a .bprd file by checking Save the contribution specification as an Ant script in the workspace
(.bprd) checkbox near the bottom of the dialog.
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5.

Navigate to the deploy folder of your project and specify a file named

loanProcessHumanCompleted.bprd--if the file already exists, you will be asked if it is ok to replace it.
The .bprd file will have all the choices that you specify during the deployment and makes re-
deploying the process a one-step process. You will see how to deploy using the .bprd file in the next

topic when you deploy the partner processes.
Your dialog should look similar to this:

= [ |

@ Export Business Process Archive

Contribution Specification
Select deployment descriptor files to be contributed, location of the contribution (business process archive, BPR)

and deployment method.

Select the deployment descriptors to contribute:

[#] 122 HumanApprovalCompleted

Select the export destination:
BPR file:  /HumanApprovalCompleted/deploy/loanProcessHumanCompleted bpr

Server Deployment Option

e

Deployment URL:  http://localhost:8080/active-bpel/services/ActiveBpelDeployBPR
Username:
Password:
Options
Group:

Description:

[#]5Save the contribution specification as an Ant script in the workspace [.bprd)

BPRD file: /HumanApprovalCompleted/deploy/loanProcessHumanCompleted.bprd

@ o) mee> ) (] |

Cancel

%

Press the Finish button.
A dialog indicating the status of the deployment is displayed:

Deploying the Loan Process
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n Deployment Complete ﬁ

Deployment Surmmary
Deployment completed with O errors and 0 warnings.

Successfully deployed a total of 1 processes.

Process Definitions

Process Definition Deployed  Wersion Running Proc. Disposition

loanProcessHumanCompleted.pdd  yes 1.0 rmaintain

Click on an item in the above table to view its Deployment Log.

Other Deployment Informaticn

[HurmnanApprovalCompleted.bpr] Processing task and notification presentation elements. =
[HurmnanApprovalCompleted.bpr] [riskAssessment.wsdl] Added resource mapped to locati |=|
[HurmnanApprovalCompleted.bpr] [loanProcess.wsdl] Added resource mapped to location |
[HumanApprovalCompleted bpr] [loanRequest.sd] Added resource mapped to location b
[HumanApprovalCompleted bpr] [ReminderToReps.html] Added resource mapped to loce
[HumanApprovalCompleted bpr] [loanCRMawsdl] Added resource mapped to lecation hin

4 | 1 3

@

L8

6. Press OK.

The Loan Process is now deployed.

Deploying the Partner Processes

You will now need to to deploy the two partner processes that the Loan Process uses to process a loan. The
BPR files for the partner services are included in the Partner Services folder of the

HumanApprovalCompleted project. You will use the Process Console to deploy the 1oanCRM.bpr and
riskAssessment.bpr BPR files. Instructions for doing this are located in Tutorial: Part 10.
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Running the Loan Process on the Server

Before you can run the process, you need to ensure that the URNs that are used in the Process Deployment
Descriptor (.pdd) file that defined the partner services are mapped to the actual URLs where those services

were deployed to. Afterward, you can run a simple Ant script to run the loan process.

1.

Open the Process Console, normally located at http://localhost:8080/activevos/ and navigate to

Admin > Configure Server > URN Mappings page and set (or verify) the following URN Mapping:

URN: urn:x-vos:loancompany

URL: http://localhost:8080/active-bpel/services/${urn.4}

& Welcome to the ActiveV0S Cons X

@ localhost:8443/a os/urn_mappings.action

b

v@ Informatica

& HOME MONITOR REPORT CATALOG ADMIN

¥ URN Mappings
ST SHIN Delete  Tenant URN
Tenant Detail Spublic aeintemnal-reporting
L Spublic ae task-nbox
T oo Spublic java:compienv/jdbc/ActiveVOS
b MultiSite

Site Properties Delete Selected

License

-

Sy Add new URN Mapping

Logged in as: aeadmin | Logout | Deploy | Help

Search: |Process I or Resource Name |

URL
hitp:focalhost:808 0/activevos/internalreports

hitp:/f J 05~

Java-comp/envijdbc/ActiveVOS

-

o~ URN  [umx-vos lsancompany

Server Properties

URL htp-iflocalhost: 5/ 4}
Logging Properties
Global Functions Add/Update Mapping
Monitering Thresholds

URN Mappings)

Tenant Definitions

-

Configure Services
Alert Service
Identity Service
Email Service
Messaging Service
Central Service

Maintenance

-

Scheduling
fon

Enter the following link in a web browser: http://localhost:8080/activevos-central/.

Sign in using the following credentials:
e Username: loanrepl

e Password: loanrepl

In the left side navigation pane, choose the Tutorial and Samples section from the Requests tab and then

select the Human Approval Completed Form.

Enter details as shown below and submit the form by pressing the Send Request button:

Running the Loan Process on the Server
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{® Informatica | scuevos Logged in as loamrep1. | Seftings | Log Out | Help

1) Home
s *|openin Tab ¥ Reset Form | Search [~
3 Forms ~ Hame ~ Desciption

Human Approval Completed Form Submit loan approval request (Human Approval Completed Sample).

w8 Tutorial and Samples Showing 1 to 1 of 1 entries

) Guide Launchpad

) Socrates avosPermissions
3 Socrates IdentityService

] Socrates Host Services

(_J Socrates Repository Services

¥ Request Process Request
Loan Process Request
Loan Type * [Moﬂgage o
First Name * |Victor
Last Name * Smith
Day Phone * 78155551212
Night Phone = 77455551212
Social Security Number * 123456733
Amount Requested * 35000

Loan Description * new ration

=

Other Info |
J ity Response Email * nobody@gmail.com
x| Repo
e First Approval Task Ref |
e .| send Request

6. Therequestis submitted to the server and the response is written into the Process Output section:
’TaMMMNMWHNMMN

} Request Process Request

* Process Output

Loan Approval Response
Response To Loan Request: underReview
Response Description:
Rejection Reason
Reason Description

7. To see the status of the running process, enter the following link in a web browser: http://
localhost:8080/activevos/.

8. Select HOME > Active Processes from the Process console:
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(‘ Informatica | Activevos Logged in as: aeadmin | Logout | Deploy | Help

5 " wee Ni
4 HOME | MONITOR  REPORT | CATALOG = ADMIN Search; |Process Id or Resource Name
£ S— Active Processes
b Posssosg D Title Ver. Start Date End Date State Tenant  Group
- DCES3ES 7588 riskAcsessment 10 2020-02-14 16:55 2020-02-14 16:55 Completed  Spublic  ParnerServices
Al Queue 7507 loanProcessHumanCompleted 7.0 2020-02-14 16:55 Running Spublic

Receive Queue

Di h Servi
i Select All/ None

¥ Task Monitoring 20 v | records per page Results 1 -2 of 2
Actie Teaks Action: | Terminate *
Work Queues
» Server Monitoring Selection Filter
Server Statistics
Deployment Logs State: All »
server Log Created between: & and a
System Performance Completed between: iz ] and &
Tenant:
Name:
Group: ) Hide System
Additional query: 4
Submit || Clear

9. Pressthe loanProcessHumanCompleted process to view the details of the process. As the following
figure shows, the process is waiting on the ReviewLoan People activity:

== Refresh | Help | Close

Process Detail:
@ Informatica
b loanProcessHumanCompleted [ID 7597] x 2 % Find
Outiine Process
n X P
& 53] jeanProcessHumanCompleled
3@ Human Interactions
-3 partnerLink v
partnerLinks > @MV&EWLDIH % Naotify
EH{x) variables T i * | 'O
- Service Of

#10) fauHanders
Undar Review

4, flow

v v @
- By Assess Risk Lf:"
- ¥ towrristc
Receivs Losm 1 Apprave
Application
@
hghrris »
.
 Process
Narme loanProcessHumanComplated
Current State Running
Start Date 2020-02-14 16:55:21
BPEL Namespace hitp:idocs oasis-open. orghwshped2 O/processiexecutabie
Target Namespace hitp:/oanProcessHumanCompleted
Suppress Join Failure yes
Process Version 7.00 =

10. The process will wait in this state until the People activity is completed or expires.

Claiming Updating and Completing the Human Task

The loan that was requested requires human intervention to complete due to the amount of the loan. To
complete the loan process a human loan representative must claim and complete the task.

Claim and Start the task
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In Process Central, select the Tasks tab. A new task was added to the list of unclaimed, open tasks for the
user loanrep1 as the screen shot below shows. If the task is not displayed press the Refresh button. Start
this task by selecting the row and pressing the Claim button and then the Open In Tab button:

| /1) Home ‘ &
Bl
B Tasks | openInTab ‘ 7] | Edl | [¥] ciaim | ,
Role: sow[4 1] @ 4 Qs ]
.- Notifications aD [2 [271 |2 Name | 2 subject \ | 2 Owner | 2 Created
o Ooe
- 3 Loan for review Please look at this loan and appr 2010-01-27 11:37
= Closed
-
Showing 1 to 1of 1 entries
Subject: Please look at this loan and approve or dediine it. (for Smith, Victor; 535’ Owner:
) Status: |
" 1 |
Loan Process Request X o
Loan Type: Mortgage 3
First Name: Victor
Last Name: Smith
Day Phone: 7315472300 ’
Night Phone: 7315472200
Social Security Humber: 123455759 I L
Amount Requested: 35000
Loan Description: new patio {
Other Info:
Response Email: nobody @gmail.com }
First Approval Task Ref:
% T Loan Approval Response .’
S o Loan Request: [To] - .
b15) Reports b Response Description: | P v
Complete the task

1. Change the value of the ResponseTolLoanRequest picklist to approved.

2. Enter some text for the ResponseDescription. Note: You must enter a string that is greater than 10
characters.
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3. Press the Complete button to complete the task.

R oo

>

|ESave(| [7] compete | b-Reieasz R Assign

Subject: Please look at this loan and approve or dedine it. {for Smith, Victor; $35000)

Owner: loanrepl
Status: [3]

- Task

Loan Process Request
Loan Type: Mortgage
First Name: Victor
Last Name: Smith
Day Phone: 7315472900
Night Phone: 7315472900
Social Security Number: 123455733
Amount Requested: 35000
Loan Description: new patio
Other Info:
Response Email: nobody @gmail. com
First Approval Task Ref:

Loan Approval Response

Response To Loan

Reason

Request: [approved (v |-

ription: |C0ngrab.|lah'ons. wyour loan is approved.

‘% Requests

| E!%‘ Reports
|

Showing 1 to 10of 1 entries

asks ﬁ Open In Tab ‘ 4
Roes stow: [ ¥ @ s |
= Notifications o subject ‘ & Qwner & Created
) open Loan for review 0
san for review
w8 Closed

n for review (3683)

Subject: Please look at this loan and approve or dedline it. (for Smith, Victor; 53!

Owner: loanrepl
Status: [7]

> Task

Loan Process Request
Loan Type: Mortgage
First Name: Victor
Last Name: Smith
Day Phone: 75315472300
Hight Phone: 7315472900
Social Security Number: 123456732
Amount Requested: 35000
Loan Description: new patio
Other Info:
Response Email: nobody @gmail.com
First Approval Task Ref:

Loan Approval Response
Response To Loan Request:

Response Descriptiol

Rejection Reason
Reason Description

TR Y L Sant o % Wa S

Claiming Updating and Completing the Human Task
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Review the Completed Loan Process

48

Once the human task completes, the 1oanProcessHumanCompleted process will continue on and complete.
You can check this by refreshing the 1oanProcessHumanCompleted process from the list of Active Processes

or from the process details

Press the Refresh button to see the current state of the process. As the figure below shows, the ReviewLoan
People activity has completed. All other activities in the process have also completed, leaving the process in

the Completed state.

Outline Process
o
=8 fioanProcessHumanComplet

& Human Interactions
2 partnerLinks

B{x) variables

Y faultHandlers

sequence

4

]

Receive Loan Application

&2l Process

Name

Current State

BPEL Namespace
Target Hamespace
Suppress Join Failure
Start Date

End Date

Process Version

d
;. Ascess Risk

Process Detail:

+ loanProcessHumanCompleted [ID 3680]

7 = v ] Reviewloan

Under Revieus

@

il -
5 lov risk

Approve

@

@
high risk

Nany

loanProcessHumanCompleted

Completed

hitp://docs. oasis-open.orgfwsbpel/2.0/process/executable
http:/laanProcessHumanCompleted

ves

2010-01-27 11:37:35

2010-01-27 11:43:40

1.00

v
: s Notify

Customer

R meaiaE

—0

4

|»
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CHAPTER 4

User Reports

This chapter includes the following topic:

e User Reports Sample, 49

User Reports Sample

This sample has reporting samples and information that will help you design and deploy your own reports.
The first step is to create the report using the reporting module in Process Developer is built on the robust
BIRT reporting engine. That engine has eclipse plug-in support, which Process Developer includes for you.
These plugins contain a rich editing environment for the construction of new reports. Once you have created
a report, you can then use a Business Process Archive (BPR file) to deploy it to the server as a resource.

After deployment, the report is available on the Report page of the console and optionally on the Reports tab
of Process Central if you specify this using a Process Central configuration (.avcconfig) file. This sample's
documentation supplies information about using reports with Process Developer, but only helps supplement
the reporting module's (BIRT) documentation. Please refer to the BIRT documentation for more details on
advanced reporting features.

This topic discusses the following:

e Getting Started

e Sample Reports

¢ Deploying Reports

e Process Data Model

e Process Data Model Entity Relation Diagram Subset

e Human Task Data Model
Getting Started

You can add a new report to any project. It is good practice to separate the reporting files from other files in
your project. In this example, the supplied reports are stored in the report folder. When you use File > New
and choose to create a new report, always use the Process Developer Template. The template has a script,
which when the report is deployed, automatically detects the Data Source connection information by using
the supplied AeBirtContext class.

If you are interested in this script, open a report that uses the template, select the Data Source, and then click
on the Script tab in the report editor. The Data Source while in Process Developer does not use the server
settings; instead, it is predefined to point to your embedded Process Server's server derby database. This
database has a limitation that only one application can connect to it at a time, so if you are creating reports
using derby make sure you stop the embedded Process Server first.
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Note: If you need to change the default, edit the data source properties to point to the database in which you
store your data.

Once you have created a new report, the next step is to define a data set. A data set is the SQL and
parameters that return the results from the database. After creating the SELECT statement, you can simply
drag the data set onto the canvas and a simple table is created for you. Now you can go ahead and make any
of the formatting changes for your report that you need.

Charts and other reporting types are also available. To use these features, you will need to consult the BIRT
documentation. A few chart samples are included to give you a sense of the capabilities. Please note that
these reports were designed and tested against the embedded server's derby database. You may need to
make modifications to the SQL Data Set for each report if you want to use them with another supported
database.

Sample Reports

Report Description

IndexedPropertyValues Displays all the indexed values in the system grouped by property name. Additionally it
can show an individual property's values using the filter.

ProcessDistribution Displays a pie chart of the distribution of process executions by process deployment (plan
I, process name). Additionally, it has a listing of the counts.

OpenTaskRoles Displays the users and groups and their roles for open tasks.

ProcessResponseTimes Displays a chart showing process response times.

ProcessStatesByDate Displays a chart showing process states by date.

ProcessStatesByProcess | Displays a chart showing process states by process name.

ProcessList Displays a list of running processes similar to the Console's Active Process List. Clicking
on a Process ID link opens the process view in a new tab.

Note: This sample also shows how to create links to the console process detail view page.

Deploying Reports

Reports are easily deployed simply by selecting them or the folder where they reside using the context menu
to select Export. From within the displayed dialog, select the Orchestration > Business Process Archive
export option. Select a location for your BPR file. Typically, you will also choose Web service deployment with
the location of your server (the default is localhost on port 8080). Also, make sure to check the Replace
existing resources checkbox or the system may not overwrite the previous report deployments unless you
have set that as the default when setting server properties.

You can also choose to save the deployment script, which is an ant script that can deploy your reports again
simply by selecting Execute from the context menu. Note the sample project has a saved deployment script
in the deploy folder that you can use to automatically deploy the sample reports. Selecting the Next button
brings you to a page where you will see your reports in the additional resources list. Choose a Process Group
name for both your entries, for example Sample Reports.
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Process Data Model

Table 1. Table 1 - Process Developer Process Tables

Table

Description

Notes

AeUserProcessView(AeProcess)

Holds the main state of a
process instance. The primary
state of the process (for
example, running, started,
completed, and so on) is
stored in the ProcessState
column.

Actual BPEL language information and
related services are stored in a related table,
called AePlan.

AeVariable

This is the set of variable data
associated with the process.

AeIndexedPropertyValue

During deployment, you can
choose to index fields from
variables in your process. This
table stores those values,
which are typically your key
performance indicators (KPI).

In order to find the property name associated
with the value data, you need to link to
AeIndexedPropertyForPlan (planis the
deployment information/table for a process
definition) and the AeIndexedProperty
tables.

AeProcessLogData

Contains the logging
information associated with a
process instance.

This is used to do root cause analysis (show
process state at a point in time) of issues. It
also contains useful reporting information.

AeProcessAttachment

Contains any attachments to
variables in the process.

The actual attachment data is stored in the
AeAttachment table as a BLOB.

AeAttachment

Stores the BLOB of an
attachment.

Others ...

User Reports Sample
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Process Data Model Entity Relation Diagram Subset

Table 2. Figure 1--ER Diagram for some of the process centric tables.

aeindexedpropertyvalue aeprocessiogdata
el GElIlIenE lProcessId(FK) BIGINT(20) Counter BIGINT(20)
[sttachmentGroupId(FK) BIGINT(20) lLocationid(F) Tr10) Srocessld BIGINT(20)
[Attachmentitemld BIGINT(20 ersionNumber(FK) NT(10) Planid MEDIUMINT(10)
pachmentteader  LONGTEXT(2147483647) indexedPropertyForPlanid(FK) MEDIUMINT(10] Locationpath  TEXT(65535)
[pttachmentContent MEDIUF:IINT(Z147453647) StringValue VARCHAR(255) nstancel ocationld INT(10)
i IDoublevalue DOUBLE(22) DefLocationld  INT(10)
DateValue DATETIME (Correlationld INT(10)
Eventld INT(10)
Sessionld INT(10)
i Sourceld INT(10)
AttachmentGroupld=AttachmentGroupld Faufthame VARCHAR(255)
] Efofisilld;P[DKEtSﬂﬂm [ancilarystr TEXT(65535)
i ocationld=Location!]
; {AncilaryInt INT(10,
IndexedPropertyForPlanid=IndexedPropertyForPianid VersionNumber=VersionNumber E:;Q‘[;E BIGI(NTEIBJ
| DataDocument  LONGTEXT(2147483647)

¥
aeprocessattachment e
e
aeindexedpropertyforplan . )| Locationid INT(10)
indexedPropertyForPlanid MEDIUMINT(10) i ersionNumber  INT(10)
Planid MEDIUMINT(10) ariableDocument LONGTEXT(2147483647)
IndexedPropertyld(FK) ~ MEDIUMINT(10)
/ariablePath VARCHAR(255)
Part VARCHAR(255) aequeuedreceive
lQuery VARCHAR(255) QueuedReceiveld  MEDIUMINT(10
i lProcessId(FK) BIGINT(20}
Processid=Processid LocationPathid INT(10)
i Processld=ProcessTd [Operation VARCHAR(255)

PartnerLinkMName ~ WARCHAR(255)
PortTypeNamespace VARCHAR(255)
PortTypelocalPart  WARCHAR(255)
ICorrelationProperties LONGTEXT(2147483647)

IndexedPropertyld=IndexedpPropertyld

| MatchHash INT(10)
aeindexedproperty ¥ ICorrelateHash INT(10)
ndexedPropertyld MEDIUMINT(10)) aeprocess | (Groupld INT(10)
[PropertyName VARCHAR(255) [Processid BIGINT(20) PartnerLinkid INT(10)
PropertyType INT(10) [Planid MEDIUMINT(10) IlowsConcurrency  TINYINT(3)
IDeploymentGroupld MEDIUMINT(10) [Processhame VARCHAR(255)

ProcessNamespace  TEXT(65535) -
ProcessDocument  LONGTEXT(2147483647)

Processstate INT(10)
ProcessStateReason  INT(10)
[StartDate DATETIME
EndDate DATETIME
IPendingInvokesCount MEDIUMINT(10)
ModifiedDate DATETIME
ModifiedCount MEDIUMINT(10})
lLocked TINYINT(3)
[Engineld MEDIUMINT(10)
lLockedDate DATETIME

ModfiedByEngineld  MEDIUMINT(10)
IDeploymentGroup ~ MEDIUMINT(10)

Human Task Data Model

In order to create human task-centric reports, you will need a basic understanding of the human task data
model. The data model is of course centered on the task, which is in the AeB4PTask table. The primary key of
this table is the ProcessId. Other tables have keys that relate back to the ProcessId in this table. As
mentioned in the process section of the data model, a system process actually handles the task state
management using the AeB4PTask table and the AeProcess table.
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Table 2 contains a short list and descriptions of task tables for which you may have monitoring or other
interests. Figure 2 contains a portion of the full data model that is centered on the AeB4PTask table.

Table 3. Table 2 - Human Task Tables

Table Description Notes

AeB4PTask Holds the main state of a task Much of the task state interaction is
instance. The primary state of the accomplished through processes. Tochange
task (for example, unclaimed, anything in a task, you must use the WS-HT
claimed, started, completed, and so Service API. Most task access information is
on) is stored in the State column see | stored in CLOB columns in this table as
Table 4 below The TaskType column | organization entities. However, for quicker
indicates whether the row contains a access when logging in, it is is also separated
task or notification, (0=task, into its own table (ReB4pTaskACL).
1=notification).

RAeB4pTaskACL This table contains the access This table controls access to task information
control list for the task. Type is zero when using the WS-HT APIL. It controls what is
for user and 1 for group. See Table 3 visible to a user who is logged into the
below for generic human role column | Process Central inbox, or another client
values. application.

ReB4PTaskPa Contains all events that change the This is used to produce the history of a task.

AeB4PTaskEventDetail state of the task.

AeB4PTaskAttachments Contains the attachments associated | This is used to store attachments that are
with a task. associated with a task and are typically

available in the task detail display.

Others ...

Table 4. Table 3--AeB4PTaskACL: GenericHumanRole Column

Role Value Description

Initiator 0 Task Initiator

Stakeholder 1 Task Stakeholder

Potential Owner 2 Potential Owner

Actual Owner 3 Actual Owner

Excluded Owner 4 An excluded owner

Business Administrator 5 Business Administrator
Notification recipient 6 Recipient of a notification task type

Table 5. Table 4--AeB4PTask: State Column

State

Value

Deferred
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Unclaimed 1
Claimed 2
Started 3
Completed 4
Skipped 5
System Error 6
Faulted 7
Exited 8
Suspended 9
Table 6. Figure 2--Human Task ER Diagram Subset
aeb4ptaskac] aeb4ptaskeventdetal
ProcessId(Fl BIGINT(20 ProcessId(FK) BIGINT(20) aeprocess
Name VARCHAR(255 IPrincipal VARCHAR(255) lProcessid BIGINT(20)
[Tvpe TINYINT(3 EventType  INT(10) Planid MEDIUMINT(10)
ExcludeFia TINYINT(S StartOwner  VARCHAR(255) Processhame VARCHAR(255)
GenericHumanRole INT(10 EndOwner  VARCHAR(255) ProcessMamespace  TEXT(65535)
‘ State TINYINT(3) ProcessDocument  LONGTEXT(2147483647)
2 Data LONGTEXT(2147483647)) ProcessState INT(10)
Rl Processtd Faulthame  VARCHAR(255) ProcessStateReason  INT(10)
[EventTimeMilis BIGINT(20) StartDate DATETIME
aebdptask ICounter BIGINT(20) EndDate DATETIME
ProcessId(FK BIGINT(20) PendingInvokesCount MEDIUMINT(10)
Name VARCHAR(255) ModifiedDate DATETIME
[TargetNamespace VARCHAR(255) ModifiedCount MEDIUMINT(10)
PresentationMame  VARCHAR(64) Locked TINYINT(3)
[Summary VARCHAR(255) Engineld MEDIUMINT(10)
(CreationTimeMilis BIGINT(20) LockedDate DATETIME
State TINYINT(3) ModifiedByEngineld  MEDIUMINT(10)
Priority INT(10) Dep}oy‘mentGmup MEDIUMINT(10)
(Owner VARCHAR(255) :

ICompletionTimeMilis  BIGINT(20)
LastModifiedTimeMilis BIGINT{20)
ExpirationDateMilis ~ BIGINT(20)
HasAttachments TINYINT(3)
HasComments TINYINT(3)
LastEscalated TimeMilis BIGINT(20)

Processld=Processid

aProcessld=Processl

HasRenderings TINYINT(3)

(CreatedBy VARCHAR(255)
[TaskInitiator VARCHAR(255)
[TaskStakeholders LONGTEXT(2147483647)
PotentialOwners LONGTEXT(2147483647)

BusinessAdministrators LONGTEXT(2147483647)
INotificationRecipients LONGTEXT(2147483647)

Processld=Processld

HasOutput TINYINT(3)
HasFault TINYINT(3)
[sSkipable TINYINT(3)
PrimarySearchBy VARCHAR(255)
StartByMilis BIGINT(19)
ICompleteByMilis BIGINT(19)
[TaskType INT(10)
jactivationTimeMilis ~ BIGINT(19)
FinalState TINYINT(3)
Data LONGTEXT(2147483647)
{archivedTimeMilis BIGINT(19)

aebdptaskpa

Processld BIGINT(20
PaExecutionCounter INT(10)
IPaProcessId(FK) BIGINT(20)
PaLocationPath TEXT(65535)
PaLocationId INT(10)
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